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Preface

Audience
This document is intended for Oracle Beehive end users who wish to access their 
information using standards-based or mobile clients. It supports Oracle Beehive 
Release 1 (1.4).

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Accessibility standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For more information, visit the Oracle Accessibility 
Program Web site at http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, some screen readers may not always read a line of text 
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor makes 
any representations regarding the accessibility of these Web sites.

TTY Access to Oracle Support Services
Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services 
within the United States of America 24 hours a day, 7 days a week. For TTY support, 
call 800.446.2398. Outside the United States, call +1.407.458.2479.

Conventions
The following text conventions are used in this document:
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Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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1 Overview

Oracle Beehive supports a number of open standards and protocols, enabling 
organizations to deploy and integrate commonly-available or custom applications to 
access Oracle Beehive data and leverage its robust feature set.

Supported Standards and Protocols
Oracle Beehive supports the following standards and protocols for each of the 
following needs:

■ File access and document management: Web-based Distributed Authoring and 
Versioning (WebDAV), File Transfer Protocol (FTP), Secure File Transfer Protocol 
(FTPS), and JSR-170

■ E-mail: Internet Message Access Protocol (IMAP) and Simple Mail Transfer 
Protocol (SMTP)

■ Time management: Calendaring Extensions to WebDAV (CalDAV)

■ Instant messaging: Extensible Messaging and Presence Protocol (XMPP) and 
XMPP-based IM applications such as Jabber

■ Mobile e-mail and data synchronization: Push Internet Message Access Protocol 
(P-IMAP) and Open Mobile Alliance Data Synchronization (OMA-DS)

Note: This release of Oracle Beehive does not support 
standards-based clients running Windows Vista.
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2 Using Standards-Based Clients

This module describes how to configure standards-based clients to connect to Oracle 
Beehive, and contains the following topics:

■ Web Clients (WebDAV)

– Cadaver

– Internet Explorer 6.x and 7

– Mac OS X Finder Web Access

– Transmit 3.5.0

– Windows XP Web Folders

– WebDAV Server Behavior in Mac OS X

■ FTP Clients

– FileZilla 2.x

– NCFTP 3.2.6

– SmartFTP 2.5.0

– Transmit 3.5.0

■ Time Management Clients (CalDAV)

– iCal 3.0

– Mozilla Lightning

– Mozilla Sunbird

■ E-mail Clients

– Mail 2.1

– Microsoft Outlook 2003

– Microsoft Outlook 2007

– Mozilla Thunderbird 2.0

■ Instant Messaging Clients

– iChat 3.1.8

– Oracle Messenger 10.1.2.3

– Pidgin 2.0

– Trillian Pro
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Web Clients (WebDAV)
Oracle Beehive supports the following WebDAV clients:

■ Cadaver

■ Internet Explorer 6.x and 7

■ Mac OS X Finder Web Access

■ Transmit 3.5.0

■ Windows XP Web Folders

Cadaver
Operating System: Linux

To configure Cadaver to connect to Oracle Beehive:
1. Open a shell.

2. Execute the cadaver 
http://<Server-Name>:<Port-Number>/content/dav command. For 
example, if your server name is barton.oracle.com and your port number is 7777, 
your command would be cadaver 
http://barton.oracle.com:7777/content/dav.

3. Enter your user name and password.

Internet Explorer 6.x and 7
Operating System: Windows XP

To configure Internet Explorer to connect to Oracle Beehive:
1. In the Address field, enter the URL to connect to Oracle Beehive using the 

following structure:

http://<Server-Name>:<Port-Number>/content/dav

If you do not know your Oracle Beehive URL, please contact your system 
administrator.

2. Enter your user name and password, and click OK.

To log out of Oracle Beehive:
Click the Logout link in the top right-hand corner of the page.

Folder Names with Symbols
If you create a folder with a name that contains symbols using Windows XP Web 
Folders, you may not be able to access the folder in Internet Explorer by clicking the 
folder link in your personal workspace. To access the folder in Internet Explorer, copy 
the address from your Windows XP Web Folder and paste it in the Internet Explorer 
Address field.

Example: Your server name is barton.oracle.com and your port 
number is 7777, so the URL you enter is 
http://barton.oracle.com:7777/content/dav.
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Mac OS X Finder Web Access
Operating System: Mac OS X 10.4.9

To configure Mac OS X Finder to connect to Oracle Beehive:
1. From the Go menu, select Connect to Server.

2. In the Server Address field, enter the URL to connect to Oracle Beehive using the 
following structure:

http://<Server-Name>:<Port-Number>/content/dav

If you do not know your Oracle Beehive URL, please contact your system 
administrator.

3. Click Connect.

4. Enter your user name and password and click OK.

Transmit 3.5.0
Operating System: Mac OS X 10.4.9

To configure Transmit to connect to Oracle Beehive:
1. In the Server field, enter the server name. For example, if your server is 

barton.oracle.com, you would enter barton.oracle.com in the Server field. If 
you do not know your server name, please contact your system administrator.

2. Enter your user name and password.

3. Enter /content/dav in the Initial Path field. If you do not know your initial 
path, please contact your system administrator.

4. Enter the port number of your server.

5. Select WebDav from the Protocol list.

6. Click Connect.

Windows XP Web Folders

Configuration

To configure Windows XP Web Folders to connect to Oracle Beehive:
1. In Windows Explorer, click My Network Places.

2. Click Add a network place.

3. Click Next.

4. Select Choose another network location and click Next.

5. In the Internet or network address field, enter the URL to connect to Oracle 
Beehive using the following structure:

Example: Your server name is barton.oracle.com and your port 
number is 7777, so the URL you enter is 
http://barton.oracle.com:7777/content/dav.
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http://<Server-Name>:<Port-Number>/content/dav

If you do not know your Oracle Beehive URL, please contact your system 
administrator.

6. Enter your user name and password, and click OK.

7. Enter a name for your network place, and click Next.

8. If you want to access this network place immediately, select the Open this 
network place when I click Finish check box.

9. Click Finish.

To log out of Oracle Beehive:
1. Click the Logout link in the top right-hand corner of the page.

2. Delete the corresponding network place from the My Network Places list.

Supported Web Folder Versions
Oracle Beehive supports the following versions of Windows XP Web Folders:

■ 11.0.6715.60 or later

■ 12.0.4518.1014 or later

Known Issues and Limitations
■ Microsoft Windows XP Professional 2002 Service Pack 2: When you create a 

folder in your personal workspace, you may receive an error message stating that 
an entity was not found. Ignore the error. The folder will be created normally.

■ Web Folders 12.0.4518.1014:

– Opening a text file will generate an error message stating that the file name, 
directory name, or volume label syntax is incorrect. Ignore the error.

– Moving or copying a file to a directory where a file with the same name exists 
will fail.

■ Explicit file versioning not supported in Manual mode: Microsoft Windows Web 
Folders does not support explicit versioning of files when versioning control is set 
to Manual mode. To update a file hosted by Web Folders when versioning is set to 
Manual mode, users must check out a file, change it, save it, and check it back in. 

WebDAV Server Behavior in Mac OS X
When right-clicking a folder or document on a WebDAV server, the following Mac OS 
X options will not work:

■ Make Alias

Example: Your server name is barton.oracle.com and your port 
number is 7777, so the URL you enter is 
http://barton.oracle.com:7777/content/dav.

Caution: When logging out of Oracle Beehive, make sure that you 
have not performed any other WebDAV-related actions between step 1 
and step 2.
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■ Create Archive

If you want to reduce the number of files sent from your desktop to the Oracle Beehive 
WebDAV server, you can disable the creation of .DS_Store files on your Macintosh 
using instructions found at the following location: 
http://docs.info.apple.com/article.html?artnum=301711

However, disabling the creation of .DS_Store files on your Macintosh will prevent you 
from copying files from a Local File System to the Oracle Beehive WebDAV server. All 
other WebDAV operations should function normally.

FTP Clients
Oracle Beehive supports the following FTP clients:

■ FileZilla 2.x

■ NCFTP 3.2.6

■ SmartFTP 2.5.0

■ Transmit 3.5.0

FileZilla 2.x
Operating System: Windows XP

Configuration

To configure FileZilla to connect to Oracle Beehive:
1. From the File menu, select Site Manager.

2. Click New Site.

3. Enter a name for the site.

4. In the Host field, enter your server name (e.g. myserver.oracle.com).

5. Enter your port number.

6. From the Servertype list, select FTP.

7. In the Logontype section, select the Normal check box.

8. Enter your user name and password.

9. Click Connect.

10. Click Save and Exit.

Windows Character Sets and Uploading
Uploading a file to a directory using the Windows-1252 user character set and a 
non-English language will fail.

NCFTP 3.2.6
Operating System: Linux

To configure NCFTP to connect to Oracle Beehive:
1. Launch NCFTP.
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2. Connect to the Oracle Beehive server using the open command with the -u (user 
name) and -P (port number) options and arguments. For example, if your user 
name, port number, and server name were jcoetzee, 7777, and barton.oracle.com, 
respectively, you would type open -u jcoetzee -P 7777 
barton.oracle.com.

3. For more information, consult the NCFTP documentation.

SmartFTP 2.5.0
Operating System: Windows XP

To configure SmartFTP to connect to Oracle Beehive:
1. From the File menu, select New Remote Browser.

2. Select Normal FTP from the Protocol list.

3. In the Host field, enter the name of your server. For example, if your server name 
is barton.oracle.com, you would enter barton.oracle.com in the Host field. If 
you do not know your server name, please contact your system administrator.

4. Enter the port number of your server in the Port field.

5. Select Username and Password from the Login Type list.

6. Enter your user name and password.

7. Click OK.

Transmit 3.5.0
Operating System: Mac OS X 10.4.9

Configuration

To configure Transmit to connect to Oracle Beehive:
1. In the Server field, enter the server name. For example, if your server name is 

barton.oracle.com, you would enter barton.oracle.com in the Server field. If 
you do not know your server name, please contact your system administrator.

2. Enter your user name and password.

3. Enter the port number of your server.

4. Select FTP from the Protocol list.

5. Click Connect.

Copying Document Aliases
When you transfer a document alias, Transmit will transfer the original document, not 
the alias.

Time Management Clients (CalDAV)
Oracle Beehive supports the following CalDAV clients:

■ iCal 3.0

■ Mozilla Lightning
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■ Mozilla Sunbird

iCal 3.0
Operating System: Mac OS X 10.5

To configure iCal to connect to Oracle Beehive:
1. Open a Web browser and enter the location of your Oracle Beehive calendar data 

using the following structure:

http://<Server-Name>:<Port-Number>/caldav

If you do not know your Oracle Beehive calendar data URL, please contact your 
system administrator.

2. Enter your Oracle Beehive user name and password. Click OK.

3. Click the Help link in the top right-hand corner of the window.

4. Copy the URL next to Apple iCal.

5. From the iCal menu, select Preferences.

6. Click the Accounts tab.

7. Click + to add an account.

8. Enter a description for the account.

9. Enter your Oracle Beehive user name and password.

10. Click the Server Options arrow.

11. In the Account URL field, paste the URL you copied in step 4.

12. Click Add. If a warning appears, ignore it and click OK.

13. Close the Accounts window. Your Oracle Beehive calendar is now listed as 
Default Calendar under the account description heading in the left-hand column.

Mozilla Lightning
Oracle Beehive supports Mozilla Lightning 0.8 and 0.9 on the Windows XP, Mac OS X 
10.4.9, and Linux operating systems.

Configuration

To configure Mozilla Lightning to connect to Oracle Beehive:

Windows and Linux  

1. Make sure that Mozilla Thunderbird 2.0 is running and that you have installed the 
Lightning add-on.

2. On the Calendars tab, click New.

3. Select On the Network and click Next.

Example: Your server name is barton.oracle.com and your port 
number is 7777, so the URL you enter is 
http://barton.oracle.com:7777/caldav.
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4. Select CalDAV from the Format list.

5. In the Location field, enter the location of your Oracle Beehive calendar data using 
the following structure:

http://<Server-Name>:<Port-Number>/caldav/<Enterprise-ID>/hom
e/<User-Email-Address>/calendars/MyCalendar

If you do not know your Oracle Beehive calendar data URL, please contact your 
system administrator.

6. Enter a calendar name, choose a display color for your calendar entries, and click 
Next.

7. Enter your user name and password, and click OK.

8. Click Finish. You are now subscribed to your Oracle Beehive calendar. It may take 
a few seconds for Lightning to retrieve the contents of your calendar from the 
server.

Macintosh  

1. Make sure that Mozilla Thunderbird 2.0 is running and that you have installed the 
Lightning add-on.

2. On the Calendars tab, click New.

3. Select On the Network and click Next.

4. Select CalDAV from the Format list.

5. In the Location field, enter the location of your Oracle Beehive calendar data using 
the following structure:

http://<Server-Name>:<Port-Number>/caldav/<Enterprise-ID>/hom
e/<User-Email-Address>/calendars/MyCalendar

If you do not know your Oracle Beehive calendar data URL, please contact your 
system administrator.

6. Enter a calendar name, choose a display color for your calendar entries, and click 
Next.

7. Enter your user name and password, and click OK.

8. Click Finish. You are now subscribed to your Oracle Beehive calendar. It may take 
a few seconds for Lightning to retrieve the contents of your calendar from the 
server.

Example: Your server name is barton.oracle.com, your port number 
is 7777, your enterprise ID is OracleBeehive, and your user ID is 
jcoetzee@acme.com. Therefore, your calendar URL is 
http://barton.oracle.com:7777/caldav/OracleBeehive/h
ome/jcoetzee@acme.com/calendars/MyCalendar.

Example: Your server name is barton.oracle.com, your port number 
is 7777, your enterprise ID is OracleBeehive, and your user ID is 
jcoetzee@acme.com. Therefore, your calendar URL is 
http://barton.oracle.com:7777/caldav/OracleBeehive/h
ome/jcoetzee@acme.com/calendars/MyCalendar.
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Time Zone Settings
Make sure you select the appropriate time zone for your location before you begin 
working with your Oracle Beehive calendar. Otherwise, your calendar events may not 
appear at the right times.

Mozilla Sunbird
Oracle Beehive supports Mozilla Sunbird 0.8 and 0.9 on the Windows XP, Mac OS X 
10.4.9, and Linux operating systems.

To configure Mozilla Sunbird to connect to Oracle Beehive:

Windows and Linux
1. From the File menu, select Subscribe to Remote Calendar.

2. Select On the Network and click Next.

3. In the Format section, select CalDAV.

4. In the Location field, enter the location of your Oracle Beehive calendar data using 
the following structure:

http://<Server-Name>:<Port-Number>/caldav/<Enterprise-ID>/hom
e/<User-Email-Address>/calendars/MyCalendar

If you do not know your Oracle Beehive calendar data URL, please contact your 
system administrator.

5. Click Next.

6. Enter a calendar name, select a calendar color, and click Next.

7. Enter your user name and password, and click OK.

8. Click Finish. You are now subscribed to your Oracle Beehive calendar.

Macintosh
1. From the File menu, select Subscribe to Remote Calendar.

2. Select On the Network and click Continue.

3. In the Format section, select CalDAV.

4. In the Location field, enter the location of your Oracle Beehive calendar data using 
the following structure:

http://<Server-Name>:<Port-Number>/caldav/<Enterprise-ID>/hom
e/<User-Email-Address>/calendars/MyCalendar

Example: Your server name is barton.oracle.com, your port number 
is 7777, your enterprise ID is OracleBeehive, and your user ID is 
jcoetzee@acme.com. Therefore, your calendar URL is 
http://barton.oracle.com:7777/caldav/OracleBeehive/h
ome/jcoetzee@acme.com/calendars/MyCalendar.
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If you do not know your Oracle Beehive calendar data URL, please contact your 
system administrator.

5. Click Continue.

6. Enter a calendar name, select a calendar color, and click Continue.

7. Enter your user name and password, and click OK.

8. Click Done. You are now subscribed to your Oracle Beehive calendar.

Troubleshooting
This section covers ways to troubleshoot issues that might arise when using a CalDAV 
client with Oracle Beehive.

Mozilla Lightning and Mozilla Sunbird

Error Messages  Occasionally, you may encounter the following error message: "There 
has been an error reading data for calendar: <Your-Calendar-Name>. It has been 
disabled until it is safe to use it." This message occurs for one of the following reasons:

■ If you receive this message but you are still able to access some calendar data, it is 
a temporary problem with the Oracle Beehive server. If you are using Lightning 
0.7 or later or Sunbird 0.7 or later, the problem should resolve itself. If you are 
using Lightning 0.5 or Sunbird 0.5, you must quit the application and restart for 
your data to appear normally.

■ You have entered the wrong calendar URL. Please verify your calendar URL with 
your system administrator.

Event Creation  If an event you have created does not appear in your Oracle Beehive 
calendar, make sure that you have not accidentally created the event in your local 
calendar instead.

Scheduling Meetings with Other Oracle Beehive Users  Meetings for which you have not yet 
indicated an attendance status appear with a ? in their titles. To confirm your 
attendance status for a meeting, change the ? to a +. To decline the meeting, delete it 
from your calendar, or change the ? to a -.

Optimizing Memory Usage  To avoid excessive memory use, set your calendar refresh 
interval to no less than 30 minutes by performing the following steps:

1. From the Tools menu, select Options.

2. Click the General tab.

3. Select the Refresh calendars every check box and set the interval to at least 30 
minutes.

4. Click OK.

Example: Your server name is barton.oracle.com, your port number 
is 7777, your enterprise ID is OracleBeehive, and your e-mail address 
is jcoetzee@acme.com. Therefore, your calendar URL is 
http://barton.oracle.com:7777/caldav/OracleBeehive/h
ome/jcoetzee@acme.com/calendars/MyCalendar.
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Limitations
■ A maximum of 250 meetings are supported per calendar.

■ Oracle Beehive 1.3 only: When you assign delegate rights to another user, it may 
take up to six hours for the user to be able to work as your delegate.

■ When you create a meeting in a team workspace, all team workspace members are 
invited by default.

■ The date range for events in your calendar is limited to one month in the past and 
two years into the future.

■ Oracle Beehive does not support the following iCal features:

– External attachments

– Delegation

– Managing available hours

– Marking events or tasks as Private

– Specifying whether one of your calendars affects your general availability

■ iCalendar categories do not map to Oracle Beehive tags.

■ You cannot create holidays in team workspaces.

E-mail Clients
Oracle Beehive supports the following e-mail clients:

■ Mail 2.1

■ Microsoft Outlook 2003

■ Microsoft Outlook 2007

■ Mozilla Thunderbird 2.0

Mail 2.1
Operating System: Mac OS X 10.4.9

To configure Mail to connect to Oracle Beehive:
1. From the New Account dialog box, select IMAP from the Account Type list.

2. Enter your name and e-mail address.

3. Enter a description for your account and click Continue.

4. Enter your incoming mail server and password in the appropriate fields and click 
Continue. If you encounter an error stating that your mail server cannot be 
reached, ignore it.

5. Enter your outgoing mail server in the field and click Continue. If you encounter 
an error stating that your mail server cannot be reached, ignore it.

6. Click Continue.

Note: You can manually refresh your calendar at any time by 
selecting Reload Remote Calendars from the File menu.
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7. Review the information you have entered. Click Go Back if you want to change 
any settings. Otherwise, click Continue to create your account.

8. Click Done.

9. Select your account from the list on the left-hand side and click the Account 
Information tab.

10. Click Server Settings.

11. Enter the port number for your outgoing mail server in the Server port field.

12. Click the Advanced tab.

13. Enter the port number for your incoming mail server in the Port field.

14. Save your changes and exit the Accounts dialog box.

Microsoft Outlook 2003
Operating System: Windows XP

This section describes how to connect to Oracle Beehive using Microsoft Outlook with 
a standard IMAP server for e-mail access only. For a complete Oracle Beehive 
experience that includes e-mail, calendar, contacts, and tasks, you must install Oracle 
Beehive Integration for Outlook. Contact your system administrator for more 
information.

To configure Microsoft Outlook to connect to Oracle Beehive:
1. From the Start menu, click Control Panel.

2. Double-click the Mail icon.

3. Click Show Profiles.

4. Click Add.

5. Enter a profile name and click OK.

6. Select Add a new e-mail account and click Next.

7. Select IMAP and click Next.

8. Enter your name and e-mail address.

9. Enter your user name and password.

10. Enter your incoming and outgoing mail servers. If you do not know your mail 
servers, please contact your system administrator.

11. Click More Settings.

12. Click the Advanced tab and enter port numbers for your incoming and outgoing 
mail servers.

13. Click OK.

14. Click Next.

15. Click Finish.

16. Click OK to exit the Mail dialog box.

Microsoft Outlook 2007
Operating System: Windows XP
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This section describes how to connect to Oracle Beehive using Microsoft Outlook with 
a standard IMAP server for e-mail access only. For a complete Oracle Beehive 
experience that includes e-mail, calendar, contacts, and tasks, you must install Oracle 
Beehive Integration for Outlook. Contact your system administrator for more 
information.

To configure Microsoft Outlook to connect to Oracle Beehive:
1. In the E-mail accounts dialog box, Outlook will ask you if you want to set up a 

new e-mail account. Select Yes and click Next.

2. Select the Manually configure server settings or additional server types check 
box and click Next.

3. Select Internet E-mail and click Next.

4. From the Account Type list, select IMAP.

5. Enter your incoming and outgoing mail servers.

6. Enter your user name and password.

7. Click More Settings.

8. Click the Advanced tab.

9. Enter port numbers for your incoming and outgoing mail servers. Click OK.

10. Click Next.

11. Click Finish.

Mozilla Thunderbird 2.0
Operating Systems: Windows XP and Linux

To configure Mozilla Thunderbird to connect to Oracle Beehive:
1. From the New Account Setup dialog box, select Email account, and click Next.

2. Enter your name and e-mail address, and click Next.

3. Select IMAP, enter the name of your incoming mail server, and click Next.

4. Enter your user name and click Next.

5. Enter a name for your account and click Next.

6. Verify that all your information is accurate. If you want to edit your account 
information, click Back. Otherwise, click Finish to create your account.

7. From the Tools menu, select Account Settings.

8. Select Server Settings from the list on the left-hand side. Enter a port number for 
your incoming mail server.

9. Select Outgoing Server (SMTP) from the list on the left-hand side. Select your 
server and click Edit.

10. Enter a port number for your outgoing mail server and click OK.

11. Click OK to save your account settings.

Instant Messaging Clients
Oracle Beehive supports the following instant messaging (IM) clients:
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■ iChat 3.1.8

■ Oracle Messenger 10.1.2.3

■ Pidgin 2.0

■ Trillian Pro

iChat 3.1.8
Operating System: Mac OS X 10.4.9

To configure iChat to connect to Oracle Beehive:
1. From the iChat menu, select Preferences.

2. Click + to create an account.

3. Select Jabber Account from the Account Type list.

4. Enter your e-mail address and password. The server field will automatically fill in 
the appropriate server name.

5. Enter a description for this account and click Add.

6. Click Server Settings and enter the port number for your Jabber server. If you do 
not know your port number, please contact your system administrator.

7. From the iChat menu, select Log In to Jabber.

Oracle Messenger 10.1.2.3
Operating System: Windows XP

To configure Oracle Messenger to connect to Oracle Beehive:
1. From the Tools menu, select Options.

2. Click the Connection tab and select the Manual Configuration for XMPP 
Connection check box.

3. In the XMPP Host field, enter the name of your server. For example, if your server 
name is barton.oracle.com, you would enter barton.oracle.com in the field.

4. In the XMPP Port field, enter the port number for your server.

5. Click OK.

6. From the File menu, select Sign In.

7. Enter your user name and password.

8. In the Resource field, enter your enterprise identifier. If you do not know your 
enterprise identifier, please contact your system administrator.

9. Click OK.

Pidgin 2.0
Operating Systems: Windows XP, Linux

To configure Pidgin to connect to Oracle Beehive:
1. Click Add.

2. On the Basic tab, choose XMPP from the Protocol list.
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3. Enter your screen name (typically your full e-mail address). If you do not know 
your screen name, please contact your system administrator.

4. In the Domain field, enter your domain name. For example, if your server name 
were barton.oracle.com, you would enter oracle.com as the domain name.

5. Click the Advanced tab. If you are not using TLS, select the Allow plaintext auth 
over unencrypted streams check box.

6. Enter the full name of your server in the Connect server: field. For example, if 
your server name is barton.oracle.com, you would enter barton.oracle.com in 
the field.

7. Click Save.

Trillian Pro
Operating System: Windows XP

To configure Trillian Pro to connect to Oracle Beehive:
1. From the Trillian menu, select Trillian Preferences.

2. Click Plugins.

3. Select the Jabber check box.

4. Click Identities & Connections in the list on the left-hand side.

5. Select an identity and click Add a new connection. Select Jabber from the list.

6. In the JID field, enter your user name and your XMPP domain name using the 
<User-Name>@<Domain-Name> structure. For example, if your user name is 
jcoetzee and your XMPP domain name is oracle.com, you enter 
jcoetzee@oracle.com in the JID field.

7. Enter your server name.

8. Enter your password.

9. Click Connect.

Troubleshooting
You cannot transfer files securely when using an instant messaging client with Oracle 
Beehive. Though your SSL connection to the server is secure, files will be not securely 
transferred. When you attempt to transfer a file, you will be warned that the file 
transfer will be unsecure. You can then proceed with the unsecure file transfer or 
cancel the operation.
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3 Configuring Mobile Devices

This module describes how to configure your mobile device to connect to Oracle 
Beehive, and contains the following topics:

■ Registering Your Mobile Device

■ Enabling SMS Notifications

■ Windows Pocket PC and Windows SmartPhone

■ Palm OS

■ RIM BlackBerry

■ Sony Ericsson Symbian

■ Sony Ericsson Java Platform

■ Nokia Series 40

■ Nokia Series 60

■ Apple iPhone

■ Instant Messaging on Your Mobile Device

■ Customizing Synchronization

Registering Your Mobile Device

To register your mobile device:
1. Access the Oracle Beehive User Preferences page through a supported Web 

browser. Typically, the URL will follow this structure:

http://<Your-Server-Name>:<Port-Number>/uss/ or 
https://<Your-Server-Name>:<Port-Number>/uss/

2. Enter your user name and password, and log in.

3. Click Mobile Devices.

4. Enter the phone number of your mobile device, including the country code, and 
click Add. Oracle Beehive will send a Short Message Service (SMS) message to 
your mobile device. Click the URL provided within the SMS message to complete 
the registration.
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Enabling SMS Notifications

To enable SMS notifications for your mobile device:
1. Access the Oracle Beehive User Preferences page through a supported Web 

browser. Typically, the URL will follow this structure:

http://<Your-Server-Name>:<Port-Number>/uss/ or 
https://<Your-Server-Name>:<Port-Number>/uss/

2. Enter your user name and password, and log in.

3. Click Mobile Devices.

4. Before you can receive SMS notifications, you must register your mobile device. To 
add your mobile device to the My Devices list, enter the phone number of your 
mobile device, including the country code, and click Add. Alternatively, if your 
mobile device is already on the My Devices list, select Edit from the Actions 
column.

5. Select the Enable SMS notifications on this device check box to send yourself 
SMS reminders for meetings you are planning to attend.

6. Optionally, edit the name of your mobile device.

7. Select Save.

Windows Pocket PC and Windows SmartPhone
This section contains the following topics related to using supported Windows Pocket 
PC and Windows SmartPhone devices with Oracle Beehive:

■ Supported Devices

■ Over-the-Air Configuration Using SMS

■ Over-the-Air Configuration Without SMS

■ Configuration Using ActiveSync

■ Synchronizing Your Data on a Pocket PC

■ Synchronizing Your Data on a SmartPhone

■ E-mail

Note: If your device fails to receive the SMS message, you will need 
to manually access the mobile device User Preferences page from your 
mobile browser using 
http://<Your-Server-Name>:<Port-Number>/uss/ or 
https://<Your-Server-Name>:<Port-Number>/uss/.

Note: By default, Oracle Beehive only sends reminders as SMS 
messages when you enable this option. Non-reminder notifications 
are sent to your inbox. To have non-reminder notifications sent as 
SMS, use the options on the Oracle Beehive User Preferences page. 
For more information, see Configuring Your Notifications.
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Supported Devices
■ i-mate K-JAM

■ AT&T 3125

■ Samsung BlackJack SGH-i607

■ AT&T 8125/8525

■ AT&T Tilt

■ Palm Treo 750/700w

■ T-Mobile Dash

■ T-Mobile Wing

■ Samsung SCH-i760

■ HTC Touch

■ HTC Wizard

■ Motorola Q/Q Global

■ Moto Q music 9m/9c

■ Any Windows Mobile 5, 6, or 6.1 PocketPC or SmartPhone

Over-the-Air Configuration Using SMS
This section will instruct you on how to configure your mobile device to connect to 
Oracle Beehive through Over-the-Air (OTA) provisioning using SMS.

To configure your mobile device for OTA provisioning using SMS:
1. Register your mobile device. Upon registration, Oracle Beehive will send an SMS 

message to your mobile device. For more information, see Registering Your Mobile 
Device.

2. On your mobile device, select the link provided in the SMS message to launch 
Pocket Internet Explorer. A web page is displayed with Oracle Mobile 
Management Console available for download.

3. Select Oracle Mobile Management Console to start the download.

4. Once Oracle Mobile Management Console has finished downloading, please 
review your user information:

■ Enter your user name. Unless your system administrator has said otherwise, 
your user name is your full e-mail address.

■ Enter a valid password.

■ The Oracle Beehive URL should already appear in the appropriate field. If it is 
not present, enter the URL provided by your system administrator. Typically, 
the URL will follow this structure:

http://<Your-Server-Name>:<Port-Number>/uss/ or 
https://<Your-Server-Name>:<Port-Number>/uss/

5. Select OK.

6. Choose applications to install from the list and select OK. Synthesis AG Synthesis 
SyncML allows you to synchronize your Oracle Beehive mobile events, tasks, 
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and contacts with your computer. Oracle Beehive Mobile Client allows you to 
send and receive messages on your mobile device.

7. Select Yes to any prompts you receive during installation.

Over-the-Air Configuration Without SMS

To configure your mobile device for OTA provisioning without using SMS:
1. On your mobile device, launch Pocket Internet Explorer.

2. Enter the Oracle Beehive URL that your system administrator has provided. 
Normally the URL should be either 
http://<Your-Server-Name>:<Port-Number>/uss/ or 
https://<Your-Server-Name>:<Port-Number>/uss/.

3. Follow steps 3 through 8 in Over-the-Air Configuration Using SMS.

Configuration Using ActiveSync

To configure your mobile device using ActiveSync:
1. Access the Oracle Beehive User Preferences page through a supported Web 

browser. Typically, the URL will follow this structure:

http://<Your-Server-Name>/uss/ or 
https://<Your-Server-Name>/uss/

2. Enter your user name and password, and log in.

3. Click Mobile Devices.

4. Select Oracle Mobile Management Console for Windows Mobile 5 & 6 to start 
the download.

5. Once you have finished downloading the application, double-click the Beehive 
executable to start installation.

6. Make sure that your mobile device is connected to your computer (cradled, 
connected via USB cable, or connected wirelessly via Bluetooth).

7. Make sure that ActiveSync is running, then select Next.

8. Enter your user name. Typically, this is your work e-mail address. If you do not 
know your user name, please contact your system administrator.

9. The Oracle Beehive URL should already appear in the appropriate field. If it is not 
present, enter the URL provided by your system administrator.

10. Select Next. ActiveSync will copy the needed files to your mobile device.

Note: Synthesis SyncML is a third-party application. In order for 
Synthesis SyncML to appear in the list, your organization must have 
purchased the application and made it available in Oracle Beehive. 
Please contact your system administrator for more information.

Note: If you have a storage card, choose whether to install Oracle 
Beehive on the storage card or on your mobile device, and select 
Install.
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11. Review the user name and URL you entered before proceeding.

12. Enter your password and select OK.

13. Select applications to install from the list and select OK. Synthesis AG Synthesis 
SyncML allows you to synchronize your Oracle Beehive mobile events, tasks, 
and contacts with your computer. Oracle Beehive Mobile Client allows you to 
send and receive messages on your mobile device.

14. If you have a storage card, choose whether to install Oracle Beehive on the 
storage card or on your mobile device, and select Install.

15. Select Done or OK (depending on your device) to complete installation of Oracle 
Beehive.

Synchronizing Your Data on a Pocket PC

To synchronize your data:
1. On your device, select Start, then Programs.

2. Select Synthesis SyncML.

3. Select Extras, then Profile Settings.

4. If the location of your Oracle Beehive data is not already provided, enter the 
location in the SyncML Service Address field using the following structure:

http://<Server-Name>:<Port-Number>/mobilesync/server

5. Enter your Oracle Beehive user name and password.

6. Under the Synchronize heading, select the data you want to synchronize: events, 
tasks, meetings, and/or messages.

7. Select General.

8. Select OK.

9. To synchronize your data, select the arrowed circle.

Note: Synthesis SyncML is a third-party application. In order for 
Synthesis SyncML to appear in the list, your organization must have 
purchased the application and made it available to Oracle Beehive 
users. Please contact your system administrator for more information.

Note: Synthesis SyncML is a third-party client available at 
http://www.synthesis.ch/.

Example: For example, if your server name is barton.oracle.com 
and your port number is 7777, you enter 
http://barton.oracle.com:7777/mobilesync/server in the 
field.
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Synchronizing Your Data on a SmartPhone

To synchronize your data:
1. On your device, select Start, then Programs.

2. Select Synthesis SyncML.

3. Select Menu, then Profile Settings.

4. If the location of your Oracle Beehive data is not already provided, enter the 
location in the SyncML Server Address field using the following structure:

http://<Server-Name>:<Port-Number>/mobilesync/server

5. Enter your Oracle Beehive user name and password.

6. Under the Data heading, select the data you want to synchronize: events, tasks, 
meetings, and/or messages.

7. Select Save.

8. To synchronize your data, select Sync.

E-mail
Following installation, Oracle Beehive Mobile Client should start automatically and 
display the current working mode for Oracle Beehive. If the default working mode is 
Offline, select Menu, then Synchronize, then Done.

Once Oracle Beehive Mobile Client has started up, it will synchronize your e-mail for 
the first time. When you start the Pocket Outlook Messaging application, you will see 
a new account called Beehive that contains all your e-mail.

Palm OS
This section contains the following topics related to using supported Palm OS devices 
with Oracle Beehive:

■ Supported Devices

■ Configuration

■ Synchronizing Your Datads

■ E-mail

■ Known Issues

Note: Synthesis SyncML is a third-party client available at 
http://www.synthesis.ch/.

Example: For example, if your server name is barton.oracle.com 
and your port number is 7777, you enter 
http://barton.oracle.com:7777/mobilesync/server in the 
field.
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Supported Devices
■ Palm Treo 680 running Palm OS 5.4.9

■ Palm Treo 755p or 700p running Palm OS 5.4.9

■ Palm Centro

■ Any device running Palm OS 4.x

Configuration

To configure your mobile device for Oracle Beehive:
1. Register your mobile device. Upon registration, Oracle Beehive will send an SMS 

message to your mobile device. For more information, see Registering Your Mobile 
Device.

2. Log in to Oracle Beehive using the link provided in the SMS message. You will see 
a list of available applications to install.

3. If you do not have Palm Application Installer installed on your mobile device, 
download and install it:

1. Select Readme.

2. Select the Palm Application Installer link.

3. Select a location for your download and select Yes.

4. Once the download has completed, select Save and Open.

5. Select Yes.

4. Go back to the list of available applications to install and select Synthesis SyncML 
Client PRO.

Note: If your device fails to receive the SMS message, you will need 
to manually access the mobile device log-in page from your mobile 
browser using the same URL you used to register. For more 
information, see Registering Your Mobile Device.

Note: In order for Palm Application Installer to appear in the list, 
your organization must have made it available to Oracle Beehive 
users. If the application does not appear on the list, please contact 
your system administrator.

Note: Your Palm Web browser may start automatically once you 
have installed Palm Application Installer. If your Web browser 
generates a 404 error, ignore it and proceed with your Oracle Beehive 
configuration.
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5. Select a location for your download and select Yes.

6. Once the download has completed, select Save and Open.

Synchronizing Your Data

To synchronize your data:
1. Select Run to start the Synthesis client.

2. Select Menu.

3. Select Profile Settings.

4. In the SyncML Server URL field, enter the location of your Oracle Beehive data 
using the following structure:

http://<Server-Name>:<Port-Number>/mobilesync/server

5. Enter your Oracle Beehive user name and password.

6. Under the Synchronize databases heading, select the item types you want to 
synchronize.

7. Select OK to save your settings.

8. To synchronize your data, select the arrowed circle.

E-mail
You can configure your Palm device to send and receive e-mail using ChatterEmail.

To configure your Palm device to read e-mail:
1. Access the Oracle Beehive User Preferences page through a supported Web 

browser. Typically, the URL will follow this structure: 
http://<Your-Server-Name>:<Port-Number>/uss/ or 
https://<Your-Server-Name>:<Port-Number>/uss/

2. Select ChatterEmail Client to start the download.

Note: Synthesis SyncML is a third-party application. In order for 
Synthesis SyncML to appear in the list, your organization must have 
purchased the application and made it available to Oracle Beehive 
users. Please contact your system administrator for more information.

Example: For example, if your server name is barton.oracle.com and 
your port number is 7777, you enter 
http://barton.oracle.com:7777/mobilesync/server in the 
field.

Note: ChatterEmail is a Palm application. In order for ChatterEmail 
to appear in the list of mobile software available for download, your 
system administrator must have purchased ChatterEmail and made it 
available to Oracle Beehive users.
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3. Choose an install location and select Yes to start the download.

4. Once the download is complete, select Save and open.

5. Click Run to start ChatterEmail.

6. Enter your Oracle Beehive display name, e-mail address, and password. If you do 
not know any of these values, please contact your system administrator.

7. Select OK.

8. Select the top left-hand corner of your screen.

9. Select Edit Mailbox.

10. In the IMAP Server field, enter your incoming mail server address and port 
number using the following structure: <Server-Name>:<Port-Number>

11. Select the SMTP tab.

12. In the Login Name field, enter your Oracle Beehive user name. Typically, this is 
your full work e-mail address.

13. Optionally, enter your SMTP (outgoing) mail server in the Server field if it is 
different from your IMAP (incoming) mail server. Please contact your system 
administrator for more information.

14. Depending on your organization’s configuration, you may have to select different 
authentication protocols for your SMTP settings and enter your user ID. Please 
contact your system administrator for more information.

15. Click OK. ChatterEmail will connect to the Oracle Beehive server and download 
your e-mail messages.

Known Issues
If you are synchronizing e-mail between your Palm device and the Oracle Beehive 
server using the Synthesis SyncML client, do not use the Reply All feature on your 
Palm device. Using Reply All will cause the e-mail addresses in the To: field to 
become invalid during synchronization.

RIM BlackBerry
This section contains the following topics related to using supported RIM Blackberry 
devices with Oracle Beehive:

■ Supported Devices

■ Configuring and Synchronizing Your Data

Supported Devices
■ Pearl 8100

■ Curve 8300

■ 8200, 8700, and 8800 series

Example: For example, if your server name is barton.oracle.com and 
your port number is 993, you enter barton.oracle.com:993 in the 
field.
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■ 7100 and 7200 series

Configuring and Synchronizing Your Data

To configure your mobile device and synchronize your Oracle Beehive data:
1. Download the latest SyncML client for Blackberry at http://www.nexthaus.com.

2. Install the SyncML client on your device.

3. From your device’s main menu, select SyncJe-BB.

4. Select Menu, then Setting.

5. In the Server URL field, enter the location of your Oracle Beehive data using the 
http://<server-name>:<port-number>/mobilesync structure. For 
example, if your server name is faulkner.oracle.com and your port number 
is 7777, you enter http://faulkner.oracle.com:7777/mobilesync in the 
field.

6. Enter your Oracle Beehive user name and password.

7. Select the data store(s) you want to synchronize.

8. Enter folder names for your Oracle Beehive items:

■ Contacts: ./contacts

■ Calendar: ./calendar/events

■ ToDo: ./calendar/tasks

9. Select Menu, then Save.

10. To synchronize your data, select Menu, then Start Sync. Select Continue if you 
encounter any errors.

Sony Ericsson Symbian
This section contains the following topics related to using supported Sony Ericsson 
Symbian devices with Oracle Beehive:

■ Supported Devices

■ Automatic Configuration

■ Configuring and Synchronizing Your Data

■ E-mail

Supported Devices
■ M600i

■ P990i

■ P1

Automatic Configuration
When you register a Sony Ericsson Symbian device, Oracle Beehive will ask you if 
you want to receive SMS messages to automatically configure your device to 
synchronize data and send and receive e-mail. For more information, see Registering 
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Your Mobile Device. If you do not want Oracle Beehive to automatically configure 
your mobile device, see Configuring and Synchronizing Your Data and E-mail.

Configuring and Synchronizing Your Data

To configure your mobile device and synchronize your Oracle Beehive data:
1. On your device, select Menu, then Tools.

2. Select Remote Sync, then More.

3. Select Edit Profile.

4. If the location of your Oracle Beehive data is not already provided, enter the 
location in the Server Address field using the following structure:

http://<Server-Name>:<Port-Number>/mobilesync/server

5. Enter your Oracle Beehive user name and password.

6. Select Done.

7. Select the item types you want to synchronize using the appropriate check boxes.

8. For each item type you have chosen, enter the following values in the appropriate 
Server database field:

■ Calendar or Tasks: ./calendar

■ E-mail: ./email

■ Address Book: ./contacts

■ Notes: ./notes

9. To synchronize your data, select Sync.

E-mail
You can configure your mobile device to send and receive e-mail using IMAP and 
SMTP servers.

To configure your device to send and receive e-mail:
1. Select Menu, then Messaging.

2. From the pull-down menu, select Messaging, then Settings, then Email Accounts.

3. If you have not yet created any accounts, select New.

4. Enter an account name, your display name, and your full e-mail address.

5. Select IMAP as your connection type.

Example: For example, if your server name is barton.oracle.com 
and your port number is 7777, you enter 
http://barton.oracle.com:7777/mobilesync/server in the 
field.

Note: Oracle Beehive only supports the synchronization of calendar, 
tasks, e-mail, address books, and notes.
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6. Select the Inbox tab.

7. Enter your IMAP server address, user name, and password. If you do not know 
any of these values, please contact your system administrator.

8. Deselect Limit the number of emails.

9. In the Use Download Restrictions section, select Emails smaller than and enter 3 
KB in the field.

10. Make sure the Receive Using Group option is set to the correct group. Contact 
your system administrator for more information.

11. Select the Outbox tab.

12. Enter your outgoing server address, user name, and password.

13. Make sure the Send Using Group option is set to the correct group. This group 
may vary depending on your Internet service provider. Contact your system 
administrator for more information.

14. If you are using a secure server, you must enter secure settings and port 
information:

a. Select Messaging, then Email, then Settings.

b. Select Account Settings.

c. Select your Oracle Beehive account.

d. Select More, then Edit Account.

e. Scroll down and select Encryption.

f. To configure your incoming mail server, select Incoming Server and SSL, then 
enter your secure port number. To configure your outgoing mail server, select 
Outgoing Server and SSL, then enter your secure port number.

15. Click Save.

16. Click Done to exit the Settings screen.

To send and receive e-mail:
1. Select your new account.

2. From the pull-down menu that corresponds to your new account, select Get & 
Send.

Sony Ericsson Java Platform
This section contains the following topics related to using supported Sony Ericsson 
Java Platform devices with Oracle Beehive:

■ Supported Devices

■ Synchronizing Your Data

■ E-mail

Note: If you are unable to send or receive e-mail, your Internet group 
settings may not be properly configured. Please contact your system 
administrator for more information.
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Supported Devices
■ UIQ devices

■ JP-7

■ JP-8

Synchronizing Your Data

To synchronize your Oracle Beehive data:
1. Select Menu, then Organizer, then Synchronization.

2. Select New Account, then Add.

3. Enter a profile name in the Name field.

4. If the location of your Oracle Beehive data is not already provided, enter the 
location in the Server Address field using the following structure:

http://<Server-Name>:<Port-Number>/mobilesync/server

5. Enter your Oracle Beehive user name and password.

6. Set the connection to your GPRS account. If your GPRS account is not listed, 
consult the documentation included with your device for instructions on how to 
add it.

7. In the App Settings screen, select the item types you want to synchronize.

8. For each item type you have chosen, enter the following values in the appropriate 
field:

■ Calendar: ./calendar/events

■ Tasks: ./calendar/tasks

■ Contacts: ./contacts

■ Notes: ./notes

9. Save your changes.

10. Select Menu, then Organizer.

11. Select Synchronization.

12. Highlight the newly created profile and select Start to synchronize your data.

E-mail

To configure your mobile device to use Oracle Beehive e-mail:
1. Select Menu, then Messaging, then Email.

2. Select Settings, then New Account.

Example: For example, if your server name is barton.oracle.com and 
your port number is 7777, you enter 
http://barton.oracle.com:7777/mobilesync/server in the 
field.
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3. Select Connection using and choose the service provider you are using to connect 
to the internet.

4. Select Connection Type, then IMAP4.

5. Select Incoming server, enter your server address, and select OK.

6. Select Username, then enter your Oracle Beehive user name, and select OK. 
Typically, your user name is your work e-mail address. If you do not know your 
user name, please contact your system administrator.

7. Select Password, enter your Oracle Beehive password, and select OK.

8. Select Outgoing server, enter your server address, and select OK.

9. Select Advanced Settings, then Encryption.

10. Select Incoming Server, then select your encryption type.

11. Select Outgoing Server, then select your encryption type.

12. Select Back.

13. Select Outgoing Username, enter your SMTP user name, and select OK.

14. Select Outgoing Password, enter your SMTP password, and select OK.

15. Select Incoming port, enter your IMAP port number, and select OK.

16. Select Outgoing port, enter your SMTP port number, and select OK.

17. Select Back twice.

18. Select the account you have just created.

19. Select Inbox.

20. Select Send & Receive.

Nokia Series 40
This section contains the following topics related to using supported Nokia Series 40 
devices with Oracle Beehive:

■ Supported Devices

■ Synchronizing Your Data

■ E-mail

Supported Devices
■ All 3rd Edition devices

■ All 5th Edition devices

Synchronizing Your Data

To synchronize your Oracle Beehive data:
1. Configure GPRS for all applications on your device. Please refer to the 

documentation included with your device for more information.

2. Select Menu, then Settings, then Configuration.

3. Select Personal Configuration Settings, then Add, then Synchronization.
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4. Enter a name for your account.

5. If the location of your Oracle Beehive data is not already provided, enter the 
location in the Server Address field using the following structure:

http://<Server-Name>:<Port-Number>/mobilesync/server

6. Enter your Oracle Beehive user name and password.

7. For each item type you want to synchronize, enter the following values in the 
appropriate field:

■ Calendar: ./calendar

■ Contacts: ./contacts

■ Notes: ./notes

8. Select Menu, then Settings.

9. Select the following option based on your device:

■ Series 40 3rd Edition device: Select Connectivity, then Data Transfer.

■ Series 40 5th Edition device: Select Sync and backup.

10. Select Server Synchronization, then Option.

11. Select Edit, then Synchronization Settings.

12. Select Personal Configuration.

13. Change your account to the account you have just created.

14. Return to the Synchronization screen and select Server Synchronization to 
synchronize your data.

E-mail

To configure your mobile device to use Oracle Beehive e-mail:
1. Select Menu, then Messaging.

2. Select Options, then New mailbox.

3. From the Mailbox type screen, select IMAP4 and select Next.

4. Enter your user name and select Next. Typically, your user name is your work 
e-mail address. If you do not know your user name, please contact your system 
administrator.

5. Enter your incoming mail server and select Next.

6. Enter your outgoing mail server and select Next.

7. From the Access Point in use screen, select an option:

■ Always ask: If an access point is in use, you are always asked whether you 
want to create a new access point.

Example: For example, if your server name is barton.oracle.com and 
your port number is 7777, you enter 
http://barton.oracle.com:7777/mobilesync/server in the 
field.
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■ Create new: If an access point is in use, a new access point is automatically 
created.

8. Select Next.

9. Enter a name for your mailbox and select OK.

10. Navigate back to your device’s main screen and select Menu.

11. Select E-mail Settings, then Connection Settings.

12. Select Incoming Mail.

13. Enter your Oracle Beehive user name and password and scroll down.

14. Select SSL/TLS and set Port to Default.

15. Navigate to the Outgoing E-mail Settings menu and enter your e-mail address, 
user name, and password.

16. Select StartTLS and set Port to Default.

17. Return to the Oracle Beehive main menu and select Retrieval Settings.

18. Select All.

19. Return to the Messaging menu and open the Oracle Beehive account you have just 
created. You will be prompted to connect to your mailbox. Select Yes.

Nokia Series 60
This section contains the following topics related to using supported Nokia Series 60 
devices with Oracle Beehive:

■ Supported Devices

■ Automatic Configuration

■ Synchronizing Your Data

■ E-mail

Supported Devices
■ E90 Communicator

■ E61i, E62

■ N-Series devices

■ All 3rd edition and 3rd edition FP1 devices

Automatic Configuration
When you register a Nokia Series 60 device, Oracle Beehive will ask you if you want to 
receive SMS messages to automatically configure your device to synchronize data and 
send and receive e-mail. For more information, see Registering Your Mobile Device. If 
you do not want Oracle Beehive to automatically configure your mobile device, see 
Synchronizing Your Data and E-mail
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Synchronizing Your Data

To synchronize your Oracle Beehive data:
1. Select Menu, then Connectivity.

2. Select Sync.

3. Select New Sync Profile.

4. Enter a profile name and select Next.

5. Select 1.2 from the Server Version list and select Next.

6. Choose which item types you want to synchronize by selecting the appropriate 
check boxes. Select Next.

7. If you have chosen to synchronize your contacts, enter ./contacts and select 
Next.

8. If you have chosen to synchronize your calendar, enter ./calendar and select 
Next.

9. If you have chosen to synchronize your notes, enter ./notes and select Next.

10. If the location of your Oracle Beehive data is not already provided, enter the 
location in the Host Address field using the following structure:

http://<Server-Name>:<Port-Number>/mobilesync/server

11. Select Next.

12. Enter your Oracle Beehive user name and password.

13. Select Yes to save your profile.

14. From the Sync screen, select your Oracle Beehive profile.

15. Select Options.

16. Select Synchronize.

E-mail

To configure your mobile device to use Oracle Beehive e-mail:
1. Select Menu, then Messaging.

2. Select Options, then New mailbox.

3. From the Mailbox type screen, select IMAP4 and select Next.

4. Enter your user name and select Next. Typically, your user name is your work 
e-mail address. If you do not know your user name, please contact your system 
administrator.

5. Enter your incoming mail server and select Next.

6. Enter your outgoing mail server and select Next.

Example: For example, if your server name is barton.oracle.com and 
your port number is 7777, you enter 
http://barton.oracle.com:7777/mobilesync/server in the 
field.
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7. From the Access Point in use screen, select an option:

■ Always ask: If an access point is in use, you are always asked whether you 
want to create a new access point.

■ Create new: If an access point is in use, a new access point is automatically 
created.

8. Select Next.

9. Enter a name for your mailbox and select OK.

10. Navigate back to your device’s main screen and select Menu.

11. Select E-mail Settings, then Connection Settings.

12. Select Incoming Mail.

13. Enter your Oracle Beehive user name and password and scroll down.

14. Select SSL/TLS and set Port to Default.

15. Navigate to the Outgoing E-mail Settings menu and enter your e-mail address, 
user name, and password.

16. Select StartTLS and set Port to Default.

17. Return to the Oracle Beehive main menu and select Retrieval Settings.

18. Select All.

19. Return to the Messaging menu and open the Oracle Beehive account you have just 
created. You will be prompted to connect to your mailbox. Select Yes.

Apple iPhone
This section contains the following topics related to using the Apple iPhone with 
Oracle Beehive:

■ Synchronizing Your Data

■ E-mail

Synchronizing Your Data
If you use Microsoft Outlook with Oracle Beehive Integration for Outlook, you can 
synchronize your iPhone calendar, tasks, and contacts with your Outlook folders using 
iTunes. For more information, consult the iPhone documentation at 
http://www.apple.com/itunes/sync/iphone.html.

E-mail

To configure your Apple iPhone to send and receive e-mail using Oracle 
Beehive:
1. Tap Settings.

2. Tap Mail.

3. Tap Add Account.

4. Tap Other.
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5. Enter your name, e-mail address, and a description of the Oracle Beehive e-mail 
account.

6. Enter your incoming mail server, user name, and password. Typically, your user 
name is your work e-mail address. If you do not know your incoming mail server, 
user name, or password, please contact your system administrator.

7. Enter your outgoing mail server, user name, and password.

8. Tap Save.

To review your e-mail settings:
1. Tap Settings.

2. Tap the description of your Oracle Beehive e-mail account.

3. Tap Advanced.

Instant Messaging on Your Mobile Device
IM+ All-in-One Mobile Messenger, a third-party client provided by SHAPE Services, 
enables you to communicate through instant message with other Oracle Beehive users 
using the XMPP (Jabber) protocol. For more information, visit the SHAPE Services 
web site at http://www.shapeservices.com/en/index.php.

Customizing Synchronization
You can customize different aspects of your Oracle Beehive user experience by setting 
a date range for synchronized items, choosing whether to delete items outside the 
specified date range, and choosing whether to synchronize declined events.

Modifying the Default Date Range
When you synchronize your mobile device, events and tasks outside the 
server-defined, device-specific date range are not sent to the device by default. You can 
override this behavior by modifying your device settings.

To modify the default date range for your mobile device:
Append /dr(-<Days-Past>,<Days-Future>) to the Calendar URI on your 
mobile device, where <Days-Past> is the number of days in the past, and 
<Days-Future> is the number of days in the future.

Examples:

■ ./Calendar?/dr(-7,14): Synchronizes events and tasks seven 
days in the past to 14 days in the future.

■ ./Calendar/Events?/dr(-30,60): Synchronizes events 30 
days in the past to 60 days in the future.

■ ./Calendar/Tasks?/dr(0,7): Synchronizes tasks from today 
to seven days in the future.
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Deleting Items Outside the Date Range
Whenever you synchronize your mobile device, any events or tasks outside the 
specified date range of your device are archived on the server and deleted from the 
device by default. You can override this behavior by modifying your device settings.

To control whether or not items outside your specified date range are deleted 
from your mobile device during synchronization:
Append /del(<X>) to the Calendar URI on your device. Entering TRUE for <X> 
retains items outside your date range on your mobile device. Entering FALSE for <X> 
deletes items outside your date range from your mobile device. You can have different 
settings for events and tasks.

Transferring Declined Events to Your Mobile Device
By default, Oracle Beehive does not transfer declined events to your mobile device 
during synchronization. However, you may want to view declined events on your 
device in case you decide to attend an event that you have previously declined.

To transfer declined events to your mobile device:
Append /refusedentries(<X>) to the Calendar URI on your device. Entering 
TRUE for <X> synchronizes all events, including declined events, on your mobile 
device. Entering FALSE for <X> synchronizes only accepted events and unconfirmed 
events on your mobile device.

Examples:

■ ./Calendar/Tasks?/dr(-30,60)/del(false): 
Synchronizes tasks 30 days in the past to 60 days in the future, but 
retains tasks outside this date range on your device.

■ ./Calendar/Events?/dr(-30,60)/del(true): 
Synchronizes events 30 days in the past to 60 days in the future, 
and deletes events outside this date range from your device.

Examples:

■ ./Calendar?/refusedentries(true): Synchronizes all 
events (including declined events) and tasks.

■ ./Calendar?/dr(-7,14)/refusedentries(true): 
Synchronizes all events (including declined events) and tasks 
seven days in the past and 14 days in the future.

■ ./Calendar/Events?/refusedentries(false): 
Synchronizes only accepted events and unconfirmed events.
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4Oracle Beehive Central

Oracle Beehive Central is a Web-based client that provides users a central location to 
download supported clients and delegate permissions to other users for their e-mail, 
calendars, tasks, notes, journals, and contacts.

Oracle Beehive Central supports Mozilla Firefox 2.0 in the Windows, Linux, Mac OS X, 
and Solaris operating systems, and Microsoft Internet Explorer 7.0 in the Windows 
operating system only.

Accessing Oracle Beehive Central
Oracle Beehive Central provides a public home page and a private home page. All 
users within an Oracle Beehive deployment can access and view the Oracle Beehive 
Central public home page. To access and view the private home page, users must 
provide credentials for authentication.

To access Oracle Beehive Central:
1. Open a supported Web browser and enter the URL for Oracle Beehive Central. 

Typically, the URL for Oracle Beehive Central will match the following structure:

http://<Your-Server-Name>:<Port-Number>/bcentral/home.jsp 

or

https://<Your-Server-Name>:<Port-Number>/bcentral/home.jsp

2. To access the private home page of Oracle Beehive Central, click Sign In and enter 
your user name and password.

3. To access the Download Center (to download supported clients), click Download 
Center.

4. To access the Delegation Center (to assign permissions to delegated users), click 
Delegation Center. For more information, please refer to "Delegation".
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5Delegation

This module discusses the delegation features that Oracle Beehive provides, and 
includes the following topics:

■ About Delegation

■ Adding Delegates and Setting Permissions

■ Modifying a Delegate’s Permissions

■ Removing Delegates

About Delegation
Oracle Beehive enables you to delegate permission to other users, also referred to as 
delegates or delegated users. Permissions that you can assign to delegated users include 
the ability to read, create, modify, and delete your calendar entries, e-mail messages, 
tasks, contacts, notes, and journal entries.

You specify delegates and assign permissions through the Delegation Center, provided 
by Oracle Beehive Central. To access Oracle Beehive Central, refer to "Accessing Oracle 
Beehive Central".

The Delegation Center provides the following permission sets, which you can assign 
to delegated users:

■ Manage: The delegated user can read, create, modify, and delete non-private items 
associated with the current service.

■ Review: The delegated user can only read non-private items associated with the 
current service.

■ Deny: The delegated user cannot access any items associated with the current 
service.

In addition to these permission sets, the Delegation Center provides an option that 
allows you to give a delegated user access to items that are marked Private. When 
selected, this option only applies to the services for which the delegated user has 
Manage permissions.

Adding Delegates and Setting Permissions
The Delegation Center allows you to specify the users to whom you want to delegate 
certain permissions. Before you can delegate permissions, you must add users to your 
list of delegates. Then, you assign permissions to them.
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To add a user to your list of delegates and set permissions for that user:
1. In Oracle Beehive Central, click Add Delegate. The Adding Delegates page opens.

2. In the Search field, enter the name of the user to whom you want to delegate 
permissions.

3. Click Search. The list of users that match the name you entered appears.

4. Click the user to whom you want to delegate permissions.

5. Click Add. The user’s name moves the to Delegates list box.

6. Click Next. The Setting Permissions page opens.

7. For each service, select the permissions you want to delegate to the current user. 
For more information on these options, please refer to "About Delegation".

8. If you want the delegated user to have access to items marked as Private, click the 
check box. This option only applies to the services for which the delegated user 
has Manage permissions.

9. After you make your selections, click Finish.

Modifying a Delegate’s Permissions
The Delegation Center allows you to modify the permissions assigned to your 
delegates.

To modify a delegate’s permissions:
1. In Oracle Beehive Central, select the check box next to the delegated user whose 

permissions you want to modify. You can modify the permissions of more than 
one user at a time by clicking the check boxes for multiple users.

2. Click Edit Selected. The Edit Permissions page opens.

3. For the delegated user(s) you selected, select the permissions you want to apply. 
For more information on these options, please refer to "About Delegation".

4. If you want the selected user(s) to have access to items marked as Private, click the 
check box. This option only applies to the services for which each user has Manage 
permissions.

5. To save your selections, click Save.

Removing Delegates
The Delegation Center allows you to remove users from your list of delegates.

Note: If more than one user is selected, for each service the Edit 
Permissions page will display either a common permission set (if the 
permission sets are the same for the selected users) or no permission 
set (if the permission sets are different for the selected users). In the 
latter case, you must select a permission set that will apply to all 
selected users for that service. Regardless of any differences that 
existed, all of the selected users’ permission sets will be the same for 
each service once you save your selections.
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To remove one or more than one user from your list of delegates:
1. In Oracle Beehive Central, select the check box next to each delegated user that 

you want to remove from your list of delegates.

2. Click Remove Selected. Oracle Beehive Central removes the selected user(s) from 
your list of delegates.
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6 Configuring Preferences

This module contains the following topics related to configuring your preferences for 
certain Oracle Beehive features:

■ About Preferences

■ Accessing the User Preferences Page

■ Configuring Your Out-of-Office Message

■ Configuring Your Server-Side Rules

■ Configuring Your Notifications

About Preferences
Oracle Beehive provides the User Preferences page, which enables you to configure 
preferences for any client you use to connect to Oracle Beehive. This includes 
configuring preferences for your out-of-office messages, server-side rules, and 
notifications.

Accessing the User Preferences Page

To access the User Preferences page:
1. Open a supported Web browser and enter the URL for the User Preferences page. 

Typically, the URL for the User Preferences page will match the following 
structure:

http://<Your-Server-Name>:<Port-Number>/uss

2. If prompted, enter your user name and password, and click Login. After you 
successfully log in, you can perform the following preferences-related tasks:

■ Configuring Your Out-of-Office Message

■ Configuring Your Server-Side Rules

■ Configuring Your Notifications

Note: If you do not know your server name and port number, please 
contact your system administrator.
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Configuring Your Out-of-Office Message
You can instruct Oracle Beehive to generate an automatic reply during periods when 
you are away from your workstation or out of the office.

To use the Out of Office Assistant:
1. In Oracle Beehive User Preferences page, click Out of Office.

2. Select the Enable your auto-reply message check box to enable the assistant.

3. Set a duration for your automatic reply by entering dates in the Start and End 
fields. Optionally, click the calendar button next to each field to select a date from 
a mini-calendar.

4. In the Auto-Reply Message field, enter a message indicating your unavailability.

5. Click Save.

Configuring Your Server-Side Rules
Use server-side rules if you want certain actions to be performed automatically on all 
incoming e-mail. Because these rules are stored on the Oracle Beehive server, they are 
available to you regardless of how and where you access your Oracle Beehive data.

To create a server-side rule:
1. In the Oracle Beehive User Preferences page, click Server Side Rules.

2. Click New.

3. Enter a name for the rule.

4. On the Criteria matching line, select an option. Selecting AND instructs the rule to 
perform actions only if the incoming e-mail meets all specified conditions. 
Selecting OR instructs the rule to perform actions if the incoming e-mail meets any 
specified condition.

5. In the Conditions section, select one or more conditions that will trigger the rule:

■ Subject line: The Subject line of the message contains text that you specify.

■ From line: The From field of the message contains a whole e-mail address or 
part of an e-mail address.

■ To line: The To field of the message contains a whole-email address or part of 
an e-mail address.

■ CC line: The CC field of the message contains a whole e-mail address or part 
of an e-mail address.

■ Priority is: The message Priority is set to a certain level.

6. In the Actions section, select one or more actions to be performed after the rule 
triggers:

Note: When both start and end dates are provided, the duration for 
the automatic reply is determined by the specified start and end dates. 
If you have entered an end date but no start date, the automatic rely 
becomes effective once you click Save. If you have entered a start date 
but no end date, the automatic reply remains effective until you 
deselect the Enable check box and click Save.
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■ Move to folder: Move the message to another folder. Select a folder from the 
pull-down menu.

■ Forward to recipients: Forward the message to a list of recipients. Enter a 
comma-delimited list of recipients in the field.

■ Bcc to recipients: Send a blind (Bcc) copy of the message to a list of recipients. 
Enter a comma-delimited list of recipients in the field.

■ Mark it as: Mark the message as read or flagged. In the Rule description 
section, click the action link and select an option.

■ Notify me by: Send an instant message or SMS notification for the message.

■ Delete: Delete the message.

7. Optionally, in the Exceptions section, select one or more conditions when your 
rules should not apply.

8. Click Save. If you create multiple rules, they are applied in the order in which they 
are shown in the My Email Rules section.

Configuring Your Notifications
You can configure your Oracle Beehive notifications.

To configure your Oracle Beehive notifications:
1. In the Oracle Beehive User Preferences page, click Notifications.

2. Optionally, choose a condition in the Notify me when... column and click Edit 
from the Action column.

3. Select one or more delivery channels for notifications to be sent whenever the 
selected condition is met:

■ Use default: Oracle Beehive will use the default delivery channel you 
specified in the My Notifications section of the Notifications page.

■ Inbox: Oracle Beehive will deliver e-mail notifications to your Inbox.

■ SMS: Oracle Beehive will deliver SMS notifications to your mobile device.

■ Instant Message: Oracle Beehive will deliver IM notifications to your instant 
messaging client.

4. Optionally, deselect the Enabled check box to disable notifications for the 
condition.

5. Click Save to save your changes and return to the Notifications page.

6. Optionally, repeat steps 2 through 5 for another condition in the Notify me when... 
column.

7. In the bottom half of the My Notifications section, select one or more default 
delivery channels using the check boxes provided. If you have not specified a 

Note: The Delete option overrides the Move to Folder option. In 
other words, if you select both the Move to Folder and Delete 
options, any messages that meet the conditions of the server-side rule 
will be forwarded to the Deleted Items folder instead of the folder 
specified in the Move to Folder field.
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delivery channel for a given condition, your default delivery channel(s) will be 
used. You must specify at least one default delivery channel.

8. Optionally, enable or disable notification delivery for one or more channels using 
the check boxes in the Delivery Control section.

9. Click Save.
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